
 
FinePrint Web 
Overview

FinePrint Web Edition is a free version FinePrint 2000 software.    The major difference 
between FinePrint 2000 and FinePrint Web is that FinePrint Web works only with web 
browsers including Internet Explorer, Netscape, AOL and Opera browsers.    If you are 
interested in using FinePrint 2000, click here for more information.

How FinePrint works
FinePrint uses
Advertisements 

FinePrint Tabs

The following tabs appear on the FinePrint window:

Layout tab - sets the layout of the job
Jobs tab - allows opening, saving and rearrangement of print jobs
Settings tab - changes global settings
Information tab - copyright, technical support information and paper saved statistics

Other topics

Page functions    - Previewing, inserting and deleting pages
Copying pages to the clipboard
Saving and restoring FinePrint files
Combining documents
Double sided printing 
Setting options for your printer (Options dialog)
Setting options for the FinePrint driver (paper size, orientation, default layouts)
Zooming 
Multiple FinePrint drivers
Purchase Information    
Troubleshooting
Technical Support
Tips
License



How FinePrint Works

FinePrint Web is a printer driver that sits between your browser and a physical printer.    The 
FinePrint printer driver captures printed output, displays it, scales it according to your 
instructions, and then sends it to the destination printer.

To operate:

1.    Open your browser
2.    Load your web pages as normal
3.    Select the Print command from the File menu
4.    Select the "FinePrint driver" item from the printer list in the Print dialog box
5.    Click OK
6.    Wait for the FinePrint preview dialog box to appear.
7.    Make your printing selections in the FinePrint dialog and press OK.

Definitions

Sheet - a physical sheet of paper.    A sheet may contain multiple pages
Page - a single page as output by an application
Job - a set of pages output as a unit by an application
Side - single side of a sheet
Duplex - double sided printing



FinePrint Web Uses
Save paper
Using 2, 4, or 8 up layout options can save a significant amount of paper when printing web 
pages.    Not only can you print multiple pages on a sheet, but you can delete unwanted 
pages such as web pages that contain only a button or a copyright notice.

Fix truncation problems
Often, web pages are truncated on the right, resulting in missing characters and incomplete 
bitmaps.    With FinePrint, you can preview the pages before they are printed to ensure that 
they are correct.    If they are not correct, you can use the paper scaling feature of FinePrint 
to fix the problem.

Save your web pages
Documents printed 4 or 8 up can be stored in a much smaller space than documents printed
in standard 1 up mode.

Preview and Edit your web pages
When you print to FinePrint, your pages appear in a preview window.    You can then add 
blank pages or remove pages you don't want.

Booklets
The booklet feature can be used to create compact 2 up, double-sided booklets.

Combine web pages
With FinePrint it is possible to combine different print jobs together to be printed as a single 
job.    See deferred printing for details.

FinePrint Web is a free version of FinePrint 2000 that works only with web browsers. It fixes
these common browser printing problems:

printing truncated pages on the right side or bottom of the paper
printing blank pages from sites that use forms
printing widow pages that contain useless information
printing ink wasting bitmaps from advertisements

With FinePrint Web you can:

Preview your print jobs from any browser
Save your web pages in a file
Copy them to the clipboard and paste into other applications
Combine multiple web pages into a single print job and print or save together
Print your web pages at 2, 4, or 8 pages per sheet
Print booklets and double-sided pages on any printer



Advertisements
FinePrint Web is ad supported, meaning that advertisements are placed within the software.  
It also means that your preferences with respect to which advertisements you click on, as 
well as other information can be sent from your computer to Radiate, our ad supplier.    
FinePrint Software does not collect any data directly from this software.    If you are 
interested in the privacy policy for Radiate, click here. 



Layout tab
Bypass
Use this setting if you want the output to go directly to the printer without any FinePrint 
modifications or scaling.    With this feature, it is convenient to set FinePrint as your default 
printer driver and use the Bypass option when you want output to go directly to your 
destination printer.

1 up
Use this setting when you want to print a document in the same size as it would print 
without FinePrint but want to apply FinePrint electronic stationery or forms.

2 up
This is the default setting and is the most commonly used option.    Almost all documents are
readable printed at 2 up which results in a 50% reduction in printed paper and toner.    
Document drafts, legal briefs, email, computer source code, etc. can be printed at 2 up with 
excellent results.    It is also the best setting for printing to a fax modem.    Note that fax 
users should use the high-resolution (200dpi) setting on the fax modem software before 
printing.

4 up
This is an excellent choice for those documents which contain text in sizes larger than 10 
points.    The text is generally readable and paper and toner usage are reduced by 75%.    
Review copies of large manuals may be printed using 4 up as well as court transcripts and 
presentations.    4 up is also a good choice for archiving documents that must be stored in 
printed form. In 4 up mode, the page ordering feature is available.

8 up
This setting is a good choice for handouts of presentations or any other document where the
point sizes are larger than 14.    8 up offers the maximum paper compression and is suitable 
for archival documents. In 8 up mode, the page ordering feature is available.

Booklet
This setting will create a 2 up double sided booklet.    Booklets are useful for presentations, 
brochures, or other applications where a compact format is desired.    If you have problems 
printing booklets, take a look at the booklet troubleshooting section.

Repeat
Checking this box will repeat each the same page in each available slot on a sheet.    For 
example, if the layout is set to 4 up, 4 of the same page will appear on the sheet.    

Borders

Smart - draws borders according the Ordering setting (see below).
On - draws borders around each page
Off - turns borders drawing off

Ordering 

Down - draws the pages down before drawing them across the sheet of paper in 4 and 8 up 
modes.    For example, in 4 up mode, the page ordering would be:

1 3
2 4



Across - draws the pages across before drawing them down the sheet of paper in 4 and 8 
up modes.    For example, in 4 up mode, the page ordering would be:

1 2
3 4

PDF - use this check box if you are printing landscape Acrobat (PDF) documents with 
Acrobat versions less than 4.0. 

R to L - this option appears when a Middle Eastern or bidirectional language version of 
Windows is being used.    Selecting this option will reverse the ordering of pages within a 
page and will also make booklets begin open on the left side instead of the right side.

Margins

This combo box allows you to adjust the white space around the content within a page.    The
options are:

none - no margins at all, provides the largest output 
small    - small amount of margin.    This is the default setting and gives a bit of space 
between pages 
medium - medium margins
large - large margins
original - the margins that are used by the original document.    No scaling is done with this 
setting.    This setting is automatically selected for use with forms where alignment is 
important.

Printer

Select the destination printer from this combo box.      Network printers, fax drivers and other
types of printer drivers can be selected here.

Note:    FinePrint emulates the printer that was selected in this combo box at the time 
printing occurred.    If you want to ensure that no scaling occurs to make output fit into 
printers with different hardware margins, select your destination printer before printing.    
You can select the destination printer by setting the defaults.

Copies

Set the number of complete, collated copies here.    Default is 1 copy.

Gutter

Reserves space for hole punching for placing the printout in a binder.    Options are:

·    off - no gutter
·    short side - gutter is on short side of the paper
·    long side - gutter is on long side of the paper

It is recommended that the gutter setting match the long side/short side setting in Duplex 
Orientation setting in the Options dialog

Separate jobs 

When printing multiple jobs, it is sometimes useful to have each job begin on a new sheet so



that is easier to determine where each job begins.    The options available in the Separate job
combo box are:

·    off - pages are packed as tightly as possible with new jobs flowing into the first available 
space on a sheet
·    by side - new jobs will begin on a new side of the paper.    
·    by sheet - new jobs will begin on a new sheet of paper.    FinePrint will print extra blank 
pages to ensure 

Note that if double sided printing is not being used, the by side and by sheet settings are 
equivalent.

Example:    2 three page jobs printed using a 4 up layout.

Separate jobs off

Sheet 1 Sheet 2
1      2 2          3
3      1

Separate jobs on

Sheet 1 Sheet 2
1      2 1        2
3                                 3      



Page functions - previewing, inserting and deleting pages
Previewing

FinePrint will display the actual pages of the print job, allowing a preview of the pages before
they are printed.    The scroll bar to the right of the page display view in the Layout tab can 
be used to scroll through the document.    Pages and sheets can be zoomed using either the 
magnifier cursor or by using the context menu by right clicking the pages.

Printing the selected sheet
Right click on the preview and select "Print sheet".    This will print the currently displayed 
sheet.    It will not print the back side of the sheet for double-sided printing.    Booklet pages 
will be printed as displayed on the preview and not in booklet printing sequence.

Deleting and undeleting pages

You can delete a single page or an entire job from the set of pages to be printed.    This is 
useful for deleting empty web pages from a web browser print job or deleting pages that 
were accidently printed.    Simply right-click the page you want to delete and select one of:

·    Delete this page - deletes the current page
·    Delete this job - deletes the current page and all other pages in the job that contains the 
page.
·    Enter delete page mode - enters Delete page mode (see below)

·    Undelete all - undeletes all previously deleted pages and jobs.
·    Show deleted - displays deleted pages with a red "X" drawn over them.    In this mode, the
following options are available by right-clicking on a page:

·    undelete this page - undeletes the page
·    undelete this job - undeletes the job containing the page
·    hide deleted - hides the deleted pages

Delete Page Mode

If you have a lot of pages to delete, Delete page mode can help.    While in Delete Page 
mode, clicking on page deletes it, showing a red "X" over it.    To undelete the page, click it 
again.    

To enter Delete page mode, right click anywhere on the preview pages and select "Enter 
Delete page mode".
To exit Delete Page mode, right click anywhere on the preview pages and select "Exit Delete 
Page mode".

To select a range of pages to delete, click on the start page, move the cursor or scroll to 
the end page, hold the Shift key and click on the end page.    All pages in the range will be 
deleted and displayed with the red X.

Note: if "show deleted pages" option is selected, deleted pages are drawn on the screen but
they are not printed.

Inserting pages

Blank pages can be inserted before or after any page in the document.    Right click on a 
page , select "Insert blank page", then select either "before this page" or "after this page".    





Combining jobs
In order to print multiple jobs together, print your first job to FinePrint and then go back to 
your browser and print another web page or document.        FinePrint will accumulate your 
jobs in a single set of pages that you can scroll through.    When you want to print the 
deferred jobs,    click the FinePrint icon in the Task Bar and the FinePrint dialog will appear 
allowing you set the print options.

The Separate Jobs feature is useful when using the defer function to control how different 
jobs are printed on different sides or sheets.

To see a list of all your print jobs, click the Jobs tab in the preview window.



Printer driver options - setting defaults
These options are available from the FinePrint printer driver icon in the Printers folder.    The 
Printers folder is on the Start menu, Settings option.    

Right-click the FinePrint icon and select Properties on Windows 95/98 systems and Document
Defaults on Window NT to set the following options:

Paper size
This option sets the default paper size.    FinePrint supports a large number of paper sizes as 
well as custom paper sizes.    Custom paper sizes can be created by using the Custom button
which is next to the list of available stock sizes.
 
Orientation
Set this option to either portrait or landscape.
 



Double Sided Printing
FinePrint supports printing on both sides of the paper.    This procedure is referred to as 
duplex or double-sided printing.      Set the correct paper handling for your printer in the 
Options dialog box.



Options Dialog
This dialog allows changing the settings for each of the available printers.    Since printers 
have different methods of paper handling, this dialog allows you to have different settings 
for each.    This dialog box is available by clicking the Options button on the FinePrint preview
window.

It is recommended that you use the Wizard to help configure your printer.    Click the Wizard
button at the bottom of the Options dialog box to use the Wizard.    If you choose not to use 
the Wizard, the following settings are available:

Duplex Type

Use this combo box to tell FinePrint how you want to have your pages oriented when doing 
duplex printing.      Changing this setting determines the page insertion insructions given by 
FinePrint during duplex printing.      In cases where there is a single "correct" orientation such 
as when booklets are printed, FinePrint will override this setting.    
· long side - prints duplex where you flip the pages along the longer side of the paper.    This

is is useful for standard 3 hole binding.
 

· short side - prints duplex where you flip the pages along the shorter side of the paper.    
This choice is useful when you are binding a group of pages from the short side.  

· printer default - uses the long or short side setting as selected in the printer driver.    This 
setting applies only to automatic duplex printers.

Reverse Printing
This option is useful for inkjet or other printers that require manual reverse collation of 
pages when printing is complete.    Note that this option may be required for proper 
operation of    double-sided printing if you have such a printer.    If your printer delivers pages
in the reverse order, you should check this option before attempting double-sided printing.    
Checking this option would, for example, print the pages of a 5 page document in the 
following order: 5, 4, 3, 2, 1.

Collate multiple copies - turns collation on or off.    If your printer supports hardware 
collation, FinePrint will optimize its output to take advantage of this capability. (Coming soon)

Printer duplex capabilities

· Printer has automatic duplex
Some printers have special hardware that supports double-sided printing.    Select this 
option if your printer has duplex hardware.    If your printer is not capable of automatic 
duplex printing, select Manual duplex.

· Printer requires manual Duplex 
Use this choice if your printer does not have special duplex hardware.      If you do not use 
the Wizard, you will need to determine if your printer requires you rotate or flip the paper. 
Check the appropriate options for your printer.

In the Manual Duplex mode, after FinePrint is done printing all of the front sides of the 
sheets, a dialog box will appear asking you to re-insert the pages into the printer for printing
on the backside (side that has not yet been printed) of the sheets.    Press OK on the dialog 
box when the sheets have been re-inserted into the printer.



Orientation
FinePrint will automatically calculate the most efficient page layout in most cases.    In cases 
where you need to override how FinePrint orients the sheet, use these options.

·            Portrait - formats all layouts using portrait orientation
·            Landscape - formats all layouts using landscape orientation
·            Smart - automatically selects portrait or landscape based on the current layout 
(default)
 
Printer Corrections
While FinePrint works correctly on most printers, some printers require a correction .    For 
this reason, FinePrint provides corrective measures.    They are:

Landscape duplex correction    
Some printers, notably the HP Laserjet 4000, require an adjustment in order to have the 
back sides of the sheets print in the proper orientation.    If you are printing booklets and the 
back sides are reversed, check this box.    This option applies only to printers that have 
automatic duplex.

PDF font correction
Check this box if your fonts are not printed correctly from Adobe Acrobat.        

Colored Text Processing
This combo box has options to control how colored text is processed.    
 
· Draw Normally

In most cases, colored text will print correctly with this option.

· Color correction
This option should be selected if colored text is missing or if watermarks do not print or 
are printed in black.

· Convert to black
Select this option if you prefer that all colored text be drawn as black.

Rotated Pages
This combo box has options to control how pages are rotated in the case where a document 
or group of documents has pages in both landscape and portrait orientations.
 
· Rotate entire page
            Use this option if your computer has a lot of memory and can rotate large graphics in a

single operation.

· Rotate in pieces
This is the default option and it uses memory most efficiently by rotating smaller sections 
of a page.

· Do not rotate
Select this option if you do not want pages rotated.    This will "letterbox" the page within 
the available area of the standard page rectangle.



Extra Margins

Set this option if you are missing any borders or are experiencing truncation of content when
printing.    This adjustment increases the margin from the sheet by the specified number of 
pixels.    Print a Test Page to determine the correct number of pixels.

Test Page
FinePrint will print a test page showing how many pixels to apply to the margin correction.

Custom settings
This button displays the properties dialog associated with the currently selected printer.    
From here, you can create custom settings for your printer to be used when using FinePrint.

Restore default settings
This button will restore the default settings for your printer when used with FinePrint.



Purchase Information
FinePrint Web Edition is advertising supported so there is no need to pay for it.    However, if 
you would like a version without ads, you can purchase FinePrint 2000 for $39.95.    FinePrint 
2000 has all the features of FinePrint Web plus the following functions:

1.    works with all applications, not just browsers
2.    header, footer, watermarks can be added to print jobs
3.    file saving in jpeg, tiff, and bmp formats
4.    form capability allows printing and preview on electronic letterhead and forms

Click here for more information about FinePrint 2000.



Technical Support
We are committed to providing excellent technical support for our customers.    Answers to 
frequently asked questions can be found on the Technical Support page of our website.      
Please check this page before sending a support request.

If you do not find your answer on our web site, email us at support@fineprint.com.    Include 
the following information with your support request:

1.    Version of FinePrint you are running.
2.    Whether you are using Windows 95 or Windows NT.
3.    An exact description of your problem including any error messages displayed.    
4.    Whether the problem appears in both the FinePrint preview and the printout.
5.    If you are having problems with a specific document, send an attachment containing the 
smallest part of the document that demonstrates the problem.    This will help us reproduce 
and fix the problem.
 



Jobs tab - view, arrange and save jobs
This tab allows you to rename, save, open, rearrange and delete entire jobs.    

The following functions apply to the currently selected job in the job list.    The job list shows 
the current set of jobs with the number of pages, file size and name of the job.

Move up - moves the job forward in the sequence of print jobs.    Drag and drop can also be 
used.
Move down - moves the job further back in the sequence of print jobs.    Drag and drop can 
also be used.
Delete - deletes the job, indicating the deleted state by changing the page count to "0 of x" 
where x is the number of pages contained in the job.

Undelete - undeletes the selected job, if it has been previously deleted
Open - opens a previously saved .FP file.    TIFF and text files cannot be opened with 
FinePrint.
Save - saves all non-deleted jobs in one of three formats:

.FP - saves all the existing jobs in a single .FP file 

.TXT - extracts the text from the jobs and saves a TEXT file, either with line breaks or 
without.

Renaming jobs

Jobs can be renamed by clicking on the job and waiting a second for the edit cursor to 
appear.    Edit the name and press Enter.    The new job name will be reflected in the jobs list 
and also in any stationery that refers to the job name.



Settings tab - set global attributes
The Settings tab allows to you set global settings for the operation of FinePrint.

Show Tool Tips - controls the display of tooltips, which are small help windows that appear 
when the cursor is passed over a control.    The choices are all, some and none.

Maintain column alignment - in some cases, especially with fixed pitch fonts that rely on 
extra spaces to create columns, FinePrint will adjust spacing incorrectly.    Checking this box 
fixes the problem.

Enable right to left page ordering - some languages such as Hebrew require right to left 
page ordering.    In some cases, FinePrint will automatically include the R to L checkbox in 
the Layout tab.    If FinePrint did not add the checkbox, checking this box forces the R to L 
checkbox to appear in the Layout tab.

Skip bitmap output - checking this box indicates that bitmaps should not be displayed in 
the preview nor printed.    Skipping bitmaps reduces time and ink usage when printing, 
especially on inkjet printers.

Left click zooms to - this sets the zoom level that will occur when you click using the 
magnifier cursor.    See the zoom section for descriptions of the choices

The AutoSave feature saves previous the entire contents of FinePrint sessions 
automatically. This is useful in case you need to get back to something you printed 
previously or if you suffer a system crash while printing.

You can set the number of complete sessions to save using the spin control provided.    The 
files are saved in My Documents\FinePrint files\AutoSave as FP files by default.    Default file 
locations for manual and auto saved files can be set using the "Folder locations" button.    
The AutoSave files can be deleted using the "Delete autosaved files" button.

Allow SHIFT key for quick bypass - turns quick bypass on or off.    Quick bypass is 
activated when the SHIFT key is pressed while an application print command is invoked.    
The SHIFT key can be released when the FinePrint icon disappears from the System Tray.

Show "Order supplies" buttom - turns the Order supplies link on or off.    Available only in 
the registered version.

Create new FinePrinter - clicking this button allows the creation of a new FinePrinter that 
has a copy of the settings in the current FinePrint session.    Creating multiple FinePrinters 
allows for easy access to a pre-defined set of printing attributes.    Some examples of other 
FinePrinters are:

·  FP source code printer with 2 up, stationery with date and time that is automatically sent 
to the high speed printer and has the FinePrint user interface turned off

·  FP letterhead printer with 1 up, a letterhead form, uses the heavy stock paper tray, to the 
color printer with the user interface on for preview purposes.

·     FP Draft printer with 2 up, stationery with DRAFT watermark on regular paper.

To create another FinePrinter, click the button and name your new FinePrinter.    The new 



printer will then be available in the list of printers available in the Print dialog boxes of all 
applications.

Once the new FinePrinter is created, the dialog box display setting can be modified by using 
the printer properties in the Printers folder.



Register/Information tab
Entering the Serial number

In order to remove the limitations of the trial version, your name and serial number should 
be entered in the fields on the Register tab.    Make sure you copy and paste the registration 
number from your confirmation email.    Once you have entered your name and serial 
number, click the Register button and FinePrint will be fully enabled.

If the serial number is entered correctly, this tab becomes the Information tab and contains:

·      Copyright and version information
·      Links to support web site
·      Statistics on the amount of paper saved using FinePrint.    The paper counting statistics 
can be reset to zero using the Reset button.

See our web site for further details.



License
NOTICE TO USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT. USE OF THE 
FINEPRINT    SOFTWARE PROVIDED WITH THIS AGREEMENT (THE "SOFTWARE") CONSTITUTES
YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS 
AGREEMENT, DO NOT INSTALL AND/OR USE THIS SOFTWARE. USER'S USE OF THIS 
SOFTWARE IS CONDITIONED UPON COMPLIANCE BY USER WITH THE TERMS OF THIS 
AGREEMENT.

1. LICENSE GRANT. FinePrint Software, LLC grants you a license to use the FinePrint    
software program (the "SOFTWARE") on any computer as long as the terms of this 
agreement are respected. "You" means the company, entity, or individual installing or using 
the SOFTWARE. "Use" means storing, loading, installing, executing, or displaying the 
SOFTWARE. You may not modify the SOFTWARE or disable any licensing or control features 
of the SOFTWARE except as an intended part of the SOFTWARE's programming features. This
license is not transferable to any other hardware product or other company, entity, or 
individual.

A single copy of the software can be used for personal use on different computers owned by 
the same person as long as the computers are not used at the same time.

2. OWNERSHIP. The SOFTWARE is owned and copyrighted by FinePrint Software, LLC. Your 
license confers no title or ownership in the SOFTWARE and should not be construed as a sale
of any right in the SOFTWARE.

3. COPYRIGHT. The SOFTWARE is protected by United States copyright law and international 
treaty provisions. You acknowledge that no title to the intellectual property in the SOFTWARE
is transferred to you. You further acknowledge that title and full ownership rights to the 
SOFTWARE will remain the exclusive property of FinePrint Software, LLC and you will not 
acquire any rights to the SOFTWARE except as expressly set forth in this license. You agree 
that any copies of the SOFTWARE will contain the same proprietary notices which appear on 
and in the SOFTWARE.

4. UNAUTHORIZED USE. You may not use, copy, rent, lease, sell, modify, decompile, 
disassemble, otherwise reverse engineer, or transfer the SOFTWARE except as provided in 
this agreement. Any such unauthorized use shall result in immediate and automatic 
termination of this license.

5. BUNDLING. In no case may the SOFTWARE be bundled with hardware or other non-
shareware software without written permission from FinePrint Software, LLC (16 Napier Lane,
San Francisco, CA 94133).

6. DISTRIBUTION. Provided that you verify that you are distributing the trial version of the 
SOFTWARE (you can see this information in the window title bar when you run the software: 
FinePrint trial will be printed on each sheet of paper") you are hereby licensed to make as 
many copies of the trial package of the SOFTWARE as you wish; give exact copies of the 
original trial package of the SOFTWARE to anyone; and distribute the trial package of the 
SOFTWARE in its unmodified form via electronic means (Internet, BBS's, Shareware 
distribution libraries, CD-ROMs, etc.). You may charge a distribution fee for the package, but 
you must not represent in any way that you are selling the software itself.

Distribution of the commercial version (i.e. not the trial) is forbidden.

All distribution of SOFTWARE is further restricted with regard to sources which also distribute
virus source code and related virus construction/creation materials. The SOFTWARE may not 



be made available on any site, CD-ROM, or with any package which makes available or 
contains viruses, virus source code, virus construction programs, or virus creation material.

Permission to distribute the SOFTWARE is not transferable, assignable, saleable, or 
franchisable. Each entity wishing to distribute the package must independently satisfy the 
terms of the distribution license.

7. U.S. GOVERNMENT INFORMATION. Use, duplication, or disclosure by the U.S. Government 
of the computer software and documentation in this package shall be subject to restrictions 
as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software 
clause at DFARS 252.277 -7013 (Oct 1988) and FAR 52.227-19 (Jun 1987). The Contractor is 
FinePrint Software, LLC,16 Napier Lane, San Francisco, CA 94133.

8. LIMITED WARRANTY. THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS. FINEPRINT 
SOFTWARE, LLC DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. NEITHER FINEPRINT 
SOFTWARE, LLC NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 
PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, 
CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
SUCH SOFTWARE, EVEN IF FINEPRINT SOFTWARE, LLC HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES OR CLAIMS. THE PERSON USING THE SOFTWARE BEARS ALL
RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

SOME JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSION MAY NOT APPLY TO 
YOU TO THE EXTENT THAT LIABILITY IS BY LAW INCAPABLE OF EXCLUSION OR RESTRICTION.

IN NO EVENT SHALL ANY THEORY OF LIABILITY EXCEED THE LICENSE FEE PAID TO FINEPRINT 
SOFTWARE, LLC.

9. SEVERABILITY. In the event of invalidity of any provision of this license, the parties agree 
that such invalidity shall not affect the validity of the remaining portions of this license.

10. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL FINEPRINT 
SOFTWARE, LLC OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, 
INCIDENTAL, OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, 
PERFORMANCE, OR USE OF THE SOFTWARE, EVEN IF FINEPRINT SOFTWARE, LLC HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL FINEPRINT SOFTWARE, 
LLC'S LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT, OR ANY OTHER THEORY OF 
LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

11. GOVERNING LAW. This agreement shall be governed by the laws of USA, excluding the 
application of its conflicts of law rules, and shall inure to the benefit of FinePrint Software, 
LLC and any successors, administrators, heirs, and assigns. Any action or proceeding 
brought by either party against the other arising out of or related to this agreement shall be 
brought only in a COURT of competent jurisdiction located in Switzerland. The parties hereby
consent to in personam jurisdiction of said courts. The United Nations Convention on 
Contracts for the International Sale of Goods is specifically disclaimed.

12. INSPECTION AND TESTING. You agree and acknowledge that you will thoroughly inspect 
and test the SOFTWARE for all of your purposes upon commencement of your use. Any suit 
or other legal action, claim, or any arbitration relating in any way to this agreement or 
software covered by it must be officially filed or officially commenced no later than 90 days 
after your first use of the software.



13. ENTIRE AGREEMENT. This is the entire agreement between you and FinePrint Software, 
LLC, which supersedes any prior agreement or understanding, whether written or oral, 
relating to the subject matter of this license.

14. RESERVED RIGHTS. All rights not expressly granted here are reserved to FinePrint 
Software, LLC.



Zooming
It is possible to zoom in on the previewed pages to get more detail or to check the printing 
accuracy.

The zoom cursor works as follows:    clicking a page in the Layout tab will use the    "fit page 
mode" by default.    The default can be changed in the Settings tab.    The following zoom 
options are available:

·    Normal - shows entire sheet with layout options
·    Fit page mode - fits entire page in the available window size
·    100 percent mode - full size of page as it would be printed
·    200 percent mode - double scaling
·    400 percent mode - quadruple scaling 
·    zoom sheet - zooms the sheet to fit page mode.

When the mouse is moved over a page in the Layout tab, the cursor will change to a zoom 
(+) cursor.    Clicking on the page will open a zoom window.    Right clicking on a page and 
selecting one of the zoom levels    accomplishes the same task.

The ESCAPE key always goes back to normal mode.



Troubleshooting
Lots of troubleshooting information can be found our support web page.    Here are a few 
solutions to common problems:

Some of my fonts appear in symbol or Wingding font, especially with Acrobat 
(PDF) documents.
Click the "pdf font correction" checkbox in the Options dialog box in the FinePrint window. 

Double sided print troubleshooting.
Problem: Pages are printed upside down on backs of pages on duplex printers.
Solution: check the "landscape duplex correction" box in the Options dialog.

Problem: The pages are correct but I have to re-order them manually when the booklet is 
finished printing.
Solution: check the "print pages in reverse" option in the Options dialog. You should only 
need to do this if you are using an inkjet or other printer where the pages must be re-
ordered when printing completes.

Problem: When doing manual duplex, the backsides of the sheets do not have the correct 
pages.
Solution: Try reversing the FACE UP/FACE down option and try again. Use a 4 page 
document to experiment with. 



Multiple FinePrint drivers
It is possible to install FinePrint multiple times, with each installation having a different set of
layout, printer or other options.    All of the "FinePrinters" will appear in the Print dialog box of
your applications.

For example, it is possible to create a printer named "FinePrint letterhead printer" that is set 
up to print on your letterhead form on your color printer, without showing the FinePrint 
dialog box.

Or you could create a "FinePrint source code printer" that prints 2 up with a page numbering 
stationery to your high speed printer.

To create a new FinePrinter, click the "Create new FinePrinter" item in the Settings tab.



Tips
Delete unwanted web pages
Do you ever print a web page and find out after you printed that the last page is blank or 
contains a single line copyright notice? With FinePrint, you can delete that page or any other 
by right clicking on the page in the preview window and selecting the "delete this page" 
item. 

Eliminate web page truncation
Do you ever print a web page and find out after you printed that the right side of the page is
cut off? With FinePrint, you can eliminate that problem. Go to the Page Setup item in the File 
menu of your browser and choose a larger paper size, such as 11x17 or A3. Your browser will
have a larger area on which to print and FinePrint will scale it down to fit on your letter size 
paper.      This can be done with any application where the size of the content exceeds that of
the paper.    

Create a travelogue
Going on vacation and using the web to do research? You can create a booklet travelogue 
that contains all your flight information, hotels, actiivites, etc. Just use the Defer feature in 
FinePrint to collect your web pages as you are browsing. When you are done, simply print 
the whole collection as a booklet. If you want to get fancy, use your word processor to create
a cover page for your booklet and print it before you start collecting your web pages.    You 
can save your work by using the Jobs tab.

Use the Defer All button when printing a large number of web pages
You can toggle the Defer button to the Defer All button by pressing the Shift key while in the 
Layout tab. Defer All will keep the FinePrint dialog box from appearing when you print so that
you can move from page to page without clicking the Defer button.



Clipboard Operations
FinePrint can copy the currently displayed sheet on the layout tab to the clipboard.    Simply 
right click anywhere on the sheet to get the context menu, select the "Copy sheet to 
clipboard" item and then one of the following format choices:

·    text - ignores all graphics and places the sheet text on the clipboard for searching and 
editing by your favorite word processor.    

·    monochrome bitmap - a monochrome bitmap rendition of the sheet.    The bitmap is 
created at screen resolution.    This option is useful when the size of the resulting file is 
important as it results in smaller files than the color bitmap option.

·    color bitmap - an exact bitmap replica of the sheet with all stationery and forms applied.   
The bitmap is created at screen resolution.    This option is useful to send a copy of the 
document via email or for further editing by graphics software.    It requires more clipboard 
memory than the monochrome bitmap option.

·  metafile - a scalable rendition of the sheet.    This option is useful if scaling the document 
is important.    This format can result in large files when saved from another application.

If a single page is desired instead of the sheet, change the layout tab    to 1 up and use the 
"Copy sheet to clipboard" again. 




